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& What's a blog?

A blog is a personal diary. A daily pulpit. A collaborative space. A political
soapbox. A breaking-news outlet. A collection of links. Your own private thoughts.
Memos to the world.

Your blog is whatever you want it to be. There are millions of them, in all shapes
and sizes, and there are no real rules.

In simple terms, a blog is a web site, where you write stuff on an ongoing basis.
New stuff shows up at the top, so your visitors can read what's new. Then they
comment on it or link to it or email you. Or not.

Since Blogger was launched in 1999, blogs have reshaped the web, impacted
politics, shaken up journalism, and enabled millions of people to have a voice and
connect with others.

And we're pretty sure the whole deal is just getting started.

The fastest way to understand blogging is to try it out. We've worked really hard
to make it really easy for you. Just click the link below, and you can be part of
the phenomenon that's transforming web and media to a participatory activity in
less than five minutes. Seriously.

What will happen then? Who knows. It might be fun, though.

And remember: Blogger is totally free, and if you have trouble, just click the Help
button from any screen, and you can find the answer you're looking for—or even

ask our dedicated support staff.
e ] crenre asioc

https://www.blogger.com/start
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& Blogger

Creating a blog is as easy as 1-2-3-4. Here are some easy steps for creating a Blogger account. Blogger
is FREE website.

Why use Blogger?

A blog gives you your own voice on the web. It's a place to collect and share things that you find
interesting— whether it's your political commentary, a personal diary, or links to web sites you want to
remember.

Many people use a blog just to organize their own thoughts, while others command influential, worldwide
audiences of thousands. Professional and amateur journalists use blogs to publish breaking news, while
personal journalers reveal inner thoughts.

Whatever you have to say, Blogger can help you say it.

Create a Google Account %9 ngggle The first step to creating
This process will create a Google account that you can use on other Google services. If you already you r Blogger aCCOU nt IS
have a Google account perhaps from Gmail, Google Groups, or Orkut, please sign in first to Create a Goog Ie
Email address You'll use this address to log in to ACCOU nt Fol IOW the
(must already exist) Blogger and other Google services. .
e steps on the website.
Enter a password I Must be at least 6 characters long.
Password strength: You can use your Gmail
Retype password | account or create a new
Display name I The name used to sign your blog Google accou nt
posts.
Word Verification Type the characters you see in the
.\u‘eck picture to the left.
[ &
Acceptance of Terms ™ 1 accept the Terms of Service Indicate that you have read and

understand Blogger's Terms of

Service

[ cornue 2
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8 Blogger,

CREATE ACCOUNT

NAME BLOG

Name your blog

Blog title

(2]

Blog address (URL) @

OR

Advanced Setup

Enter a title for your blog.

http://
Check Availability

.blogspot.com
read and link to your blog.

Want to host your blog somewhere else? Try Advanced Blog Setup. This will
allow you to host your blog somewhere other than Blogspot.

—>

&) Blogger,

E BLOG

CHOOSE TEMPLATE

Choose a template

Helpful Sites
Home
Blog Design Tips
Free Coupons
Crafts for Kids

Digital Scrapbooking

It's All FREE!

H
Free Backgrounds
F

Free Blogging Secrets
free Blog Community

Free Website Template

preview template

Choose a custom look
for your blog.
You can easily change

the template later, or

desig
is set up.

You and others will use this to

mow you need to make
up a name for your blog.

Some examples of other
blogs include:
Shaaza’s blog

Our centres blog
Teacher Blog.
Shaza’s rave

Kids rock

N /

/ You can choose a \

template to get you

started. You can

change your template at

a later if you wish.
N -

A soIle
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barraes

TEMPLATE
GENERATOR
FOR
BLOGGER‘“

FOR MOM

Freelance Writing
Telemarketing
Crafts for Kids
Online Survey
Web Calendar

Ebook Publishing

Home Jobs
Blog Hosting
Baby Shower Gifts
Designer Baby Clothing

You can choose some
amazing free
backgrounds from:
http://www.thecutestblog
ontheblock.com/




c Your blog has been created!

We've just created a blog for you. You can now add your posts to it, create your personal profile, or
customize how your blog looks.

START POSTING

Home | About | Buzz | Help | Discuss | Language | Developers | Gear | Privacy | Copyright © 1999 - 2007 Google

Voila! Your Blog
space has been
created!

Sharon's Blog - ICT & ECE

MONDAY, 19NOVEMBER 2007

CNI Dissemination Bus Trip

b i, 4 -‘ ’
o 12
* Create Your Own * |View AlllImages 11 9
condy

Posted by Shaszaat 14;14 0 comments [54] ( g 3.‘

Labels: bus trip, cluster, dissemination grésen ations

9
8 \ 4
\ 5

Sharon’s Blog
http://centralnorthisland.blogspot.com
Create your Blog now
http://www.blogger.com

LIAKIR A AR AATADER AA
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Publish your thoughts

A blog gives you your own voice on the web. It's a
place to collect and share things that you find ———
interesting— whether it's your political S
commentary, a personal diary, or links to web

sites you want to remember.

Many people use a blog just to organize their own s

thoughts, while others command influential,

worldwide audiences of thousands. Professional and amateur journalists use blogs
to publish breaking news, while personal journalers reveal inner thoughts.

Whatever you have to say, Blogger can help you say it.

<: ) (e
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Design your blog

Whether you're starting your blog or just think it's time to give your existing blog a
facelift, Blogger's user-friendly editing tools help you easily design a great-looking
page.

Templates — Our collection of templates will get you started with an attractive
site right away without you having to learn any HTML, though Blogger also allows
you to edit your blog's HTML code whenever you want.

Custom colors and fonts — When you're ready to take the next step, you can
further customize our templates to create a design that perfectly reflects you and
your blog.

Drag-and-drop page elements — Blogger's simple drag-and-drop system lets you
easily decide exactly where your posts, profiles, archives and other parts of your
blog should live on the page.

<: ) (a2




SEARCH BLOG| |MFLAG BLOG| Next Blog» sharonlee44@gmail.com | New Post | Customize | Sign Out

Sharon's Blog - ICT & ECF

I e

Click on New Post
The screen below appears

Posting Settings Layout View Blog

Create Edit Posts Moderate Comments

Title: lHow to blog -, 101
Edit Html ompose

Font 1T~ bl: Tas 8 E= == iZ S 6 Q;GAQ = 5 Preview
Itisaseasyas123
Firstly you
) Post Options g;eslscgg:‘s‘sfa"c‘;’ﬁon caylinstructions, Hbw to, blogging, h Show all
Shortcuts: press Cerl with: Sjf Bold , / = Halic, P = ish, $ = Save, 0 = Draft mwre
Return to list of pi\
Name the post by Typing in you

In the body type in your postin ou can add photos from your computer with this
bottom and one next to it is for

movies from your computer i.e photostory3

It is useful to label or put name tags to your postingyust think if you were going to want to
search for an item, what are all the possibilities you couhd call it?

When you are happy with your posting click on the Publish post button and it will appear on
your blog.
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sharonlee44®gmail.com | Dashboard

8 Sharon's Blog - ICT & ECE

Posting Settings Layout View Blog

Create Edit Posts | Moderate Comments

Title: |What only a Mum can say!
b i © i 2 d E Preview

Labels for this post:
e.g. scooters, vacation,

[ ] sa/EasorarT |

) Post Options faulfunny, mum, william tell, youtube Show all

Shortcuts: press Czel with: & = Bold, / = Halic, # = Publish, 0 = Draft rwre

If you are going to post a slide show or a Youtube - www.youtube.com video
the Html code’goes here.

Slideshows can be easily created using:

@ www.rockyou.com (OCHLJOU
AWk
@ www.smilbox.com ‘f‘”’

Microsoft*

@ http://www.microsoft.com Photo Story 3

for Windows

make show-n-tell
cool again

If you are going to be creating slideshows online it is important that you
compress the size of photos as this considerably reduces the time it take to
upload them. Also consider what time of the day you are uploading as
Internet speed varies during the day.
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8 Sharon's Blog - ICT & ECE

Posting Settings Layout View Blog

Create Edit Posts | Moderate Comments

==l =]

Labels Label Actions.. | Select: All, None
All
bus trip (1 [ \Edit View » CNI Dissemination Bus Trip bus trip, cluster, dissemination, presentations
cluster (1
dissemination (1 |~ Eqt View » What only a Mum can say! funny, mum, william tell , youtube
sl [~ Edit§View ) Lead Teacher Hui - Lego exercise with Vince Ham
Have you ever googled
your name? It can be i :
an Interestin I~ Edit » Lead teacher Hui
exercise. (1 ; . 299777
mum (1 [~ Edit » What does the future hold??222?
My New Career (1) [~ Edit Workshops for CNI Teachers
presentations (1
Truely inspiring (1) [~ Edit View ini Me
william tell (1
outube (1) [~ Edit View ) d 4 thought - Copy Right & Intellectual Propert...
|~ Edit View P CNI§egional Hui continued...... Jill Hammonds
[~ Edit View »
[~ Edit View »
[~ Edit View ) ing Cluster group
[~ Edit View » $100 Laptops f every child - that's the goal.
[~ Edit View ) Protect your gearfyreduce the fear!
[~ Edit View )» Be Selective

To edit a posting or add to it click here

8 Sharon's Blog - ICT & ECE

Posting Settings

Basic | P hin Formatting Comments Archiving Site Feed Email

Under settings you can set the time, country, permissions for an open or closed

Your Posts: All, Drafts, Published

sharonlee44@gmail.com | Dashboard | Help ' Sign out

Posts Per Page 25

1-200f 20

11/19/07 by Shaaza Delete

1 comment 10/29/07 by Shaaza Delete

9/18/07 by Shaaza Delete
9/11/07 by Shaaza Delete
8/10/07 by Shaaza Delete
8/6/07 by Shaaza Delete

2 comments 7/20/07 by Shaaza Delete

6/30/07 by Shaaza Delete
5/30/07 by Shaaza Delete
5/27/07 by Shaaza Delete
5/27/07 by Shaaza Delete

1 comment 5/27/07 by Shaaza Delete

2 comments 4/29/07 by Shaaza Delete
4/28/07 by Shaaza Delete

1 comment 4/27/07 by Shaaza Delete

sharonlee44@gmail.com | Dashboard ' Help | Sign out

Permissions

site. Take a look at each tab and make changes as required.

Post Settings Layout View Blog

Basic Publishing Formatting Comments Archiving Site Feed Email Permissions ‘

[Z Blog Authors Your blog can have up to 100 authors.

1 Author can post to this blog
Shaaza sharonlee44@gmail.com admin

Ao AuTrors ]

% Blog Readers Your blog can have up to 100 readers.

Who can view this blog?

" Anybody & Only these readers (4 people) " Only blog authors
Manda's blog amanda. i e-ed.net
annhath ann.hatherly@core-ed.net

Helen Duncan helen.duncan®core-ed.net
Naketa naketaferguson@hotmail.com
1 Open invitation
sharon.carlson@core-ed.net sent 2/27/08

Invite more people to read your blog

Separate email addresses with commas. Blog authors already have access.
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In the Layout area you are given an overview of the bones of your template and
this is where you can personalise, pretty up and add gadgets to the layout of your
blog template.

Add and Arrange Page Elements m

Click and drag to rearrange page elements on your blog.

Sharon's Blog - ICT &am...

Blog Posts

Edit
Add a Gadget
Sharon Carlson (aka Shaaza)
Edit Edit
Text
Edit

® Add a Gadget

. (search for gadgets)
Basics Basics (=
Featured
Most Popular 1-190f 19
Newest
Blog List (New!)
Categories Show off what you read with a blogroll of your favorite
News blogs.
Tools By Blogger
Communication Foll Newl +
oliowers (New!
Fun & Games - i . ( ) .
.‘ Displays a list of users who follow your blog
Finance I - By Blogger
Sports
Lifestyle Slideshow (New!)
Technology s S Add a slideshow of your photos to your blog.
Ruv RlAamnar

There are many gadgets that can be added to your template, but consider your
audience:

- What will they want to see?
- Does it have adverts attached
- Is it appropriate??
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How to post a comment on a blog site:
For invited readers:

1. Create a Google account:
https://www.google.com/accounts/NewAccount

Create a Google Account Google

Accounts

This process will create a Google account that you can use on other Google services. If you already
have a Google account perhaps from Gmail, Google Groups, or Orkut, please sign in first

Email address You'll use this address to log in to

(must already exist) Blogger and other Google services.
We'll never share it with third
parties without your permission.

Enter a password I Must be at least 6 characters long

Password strength:

Retype password I

Display name | The name used to sign your blog
posts.

Word Verification Type the characters you see in the

\“‘ e Cks picture to the left.
| &

Acceptance of Terms [ accept the Terms of Service Indicate that you have read and
understand Blogger's Terms of

Service

conrnu 2

2. Click on the link you have received from the centre in your email
account. Sign in using your new Google account access hame and
password.

This blog is open to invited readers only

http://10percentdiscount.blogspot.com/

If you are a reader of this blog, tell us who you are! Sign in using your (Go« ‘3[“ Account.

Username (Email)

Password Forgot your password?

This is not recommended for
Remember Me? I~
shared computers!
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A blog entry is called a post — scroll down to the bottom of the post that
you wish to comment on. Click on the comments link.

0o:oo ORI R

3.This will take you to a page like this. Type in your comment and click
on the “Publish your comment” button.

Post a Comment On: Blogging

Leave your comment

No comments yet. -

You can use some HTML tags, such as <b>, <i>, <a>
Comments on this blog are restricted to team
members.

Google/Blogger
You're currently posting as Helen Duncan
Use a different account

Email follow-up comments to
helen.duncan@®core-ed.net

1

4.Your comments will not be published immediately but will be available
to view shortly or when the owner of the site has allowed it to be posted

onto their site.

You might like to take a look at this youtube — how to start a blog video:
http://www.youtube.com/watch?v=bU4gXHKkejMQ  8osserHowtostntasics

Or visit my “how to Blog” blog site
www.eceblogging.blogspot.com . Blogger

ey o [ ==y
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Now it’s time to have some discussions with your team and plan for your blogs
future development. What's your purpose? What do you want on it? Consider
your audience — what do they need and want to know and share? What will
entice your audience to return? Planning becomes essential in establishing and
developing a blog.
Possibilities for blogs and future postings:

@ Centre and operation information: hours, cost, philosophy, mission

statement, contacts details etc.

@ Transition information

@ Events shared through learning stories, video, photos and
slideshows

@ Weekly journal — working smarter

@ Staff information — first names, photos, qualifications, interests

@ Events calendar

@ Parent comments and feed back

@ Parent contributions and voices

@ Newsletters, notices

@ Uploading small videos, photostory3

@ Podcasting

@ E-portfolios

@ 2777

The following are blogs worth viewing and critiquing what works well and what doesn’t.
Manaia Kindergartens blog is also worth a look as it has developed into a useful tool
for teachers, children, families and whanau. It is also worth doing a search on new
entrant and primary school blogs to see how they produce and utilise a blog site.

A useful Blog book — Publishing a Blog with Blogger 2005, Author — Elizabeth

‘& Castro.
http://blog.core-ed.net/naketa/ \\N&Q\gé L \QM

http://blog.core-ed.net/derek/

http://blog.core-ed.net/greq/
http://manaiakindergarten.blogspot.com/
http://10percentdiscount.blogspot.com/
http://hurupakikindergarten.blogspot.com/
http://kdgroom102.blohttp://classblogmeister.com/blog.php?blogger
id=1638gspot.com/

http://eceblogging.blogspot.com
http://grasslandskindergarten.blogspot.com

6 6 6 6 ¢ ¢ ¢
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How will you wuse this tool to achieve maximum
enagement, participation and access for teachers, children
and families?

Blog?

“ 8 fm ’* Some discussion with families will also be essential in the very
near future, as permissions will need to be sort for the posting
. of photos etc. Outlining “netiquette” of online participation and
9 “ ' Y' kn the protocols of the use of photos and leaving comments and
uploading information online. Discussion around the
importance and purpose of using the blog and the adding of
comments and making contributions will heighten your success with this ICT
intuitive. Maybe a parent evening to inform them of what’s been happening and
a workshop on how they can read the blog and it’s uses. I am sure once they
realise that only your families will be able to view this site they will feel
comfortable in allowing their children’s photos and movies to be posted. I am
happy to support you with this, please let me know how I can help. I look
forward to seeing where this will lead, (don’t hesitate to ring or email if you wish
to discuss this further).
Other considerations:

< Who will be responsible for regularly updating the blog?

< What role will children play in adding/creating content
and postings?

< How will all teachers become comfortable in using the 7
blog?

< What discussions and PD will be required between staff, families and
children?

Cybersafety - things to consider:
< Will the blog be private/public/invite only? And why?

< How will you ensure parents permission forms are disturbed, collected
and updated?

< What guidelines will be in place regarding the use of names, copyright
material, and information placed online?

< Do you have an ICT policy in place to protect all involved? Netsafe have
a policy template available online http://www.netsafe.org.nz
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How to remove the navigation bar on your blog

If you would like to remove this blue navbar:

8 I cciqcHELOG) | = FLAGBLOG | [FOLLOW BLOG | Next B

Go to your layout tab and select Edit HTML. Hit ‘ctrl {' to bring up the find box. Paste this in there: /* Variable definitions
Copy this code: .navbar {display:none;} and paste it directly above /* Variable definitions.
Preview and save!

Your blog will now look like this:

You will now need to go to your dashboard to access your blog.

By removing the navigation bar you eliminate the possibility of children and
families clicking on the “Next Blog” button, which can take them to any
random blog and blogger. Many centres have done this.

Now your ||enge s to

o fort and Blog
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